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Tosa® (Test on Software Applications)  

Tosa assessments and certifications will determine and validate a candidate’s proficiency 

and skill level in software applications used in a professional environment. Tosa 

assessments and certifications are designed to validate individuals’ digital skills (students, 

trainees, employees, or jobseekers) in supporting their employment, professional or 

academic objectives.  

Tosa assessments and certifications employ the Adaptive Testing methodology, which 

creates a personalized testing experience adapted to a candidate’s skill level for a selected 

software application. The score is based on the Item Response Theory using a 3-parameter 

logistic model, like the GMAT scoring method. Adaptive-based testing selects questions that 

challenge candidates to the limit of their knowledge and abilities.  

Tosa Skills Framework Objective 

This Tosa framework provides an overview of the subject areas being assessed during the 

Tosa Assessment and Certification exams. The Tosa validates candidate proficiency in the 

most popular professional Office software programs using a score on a scale from 0-1000 for 

the Certification Assessment, and a score divided into five levels, from “Beginner” to “Expert,” 

for the Diagnostic Assessment.  

The objective of this document is to present an overview of the technical skills associated 

with each of the four main Microsoft PowerPoint domains within each proficiency level. This 

information will also support educators and trainers in tailoring their training program to 

achieve desired proficiency levels.  

Unique Tosa Scoring  

The Tosa assessments and certifications are based on a unique score, divided into five levels. 

• ranging from 1 to 1000 for the certification. 

• divided into five levels, from Beginner to Expert, for assessment. 
 

Tosa® levels 
Corresponding 
Tosa® score 

Certification status & documents issued 

Expert 876 - 1000 
Certification earned - diploma & Credly 
digital badge issued 

Advanced 726 – 875 
Certification earned - diploma & Credly 
digital badge issued 

Productive 551 – 725 
Certification earned - diploma & Credly 
digital badge issued 

Basic 351 – 550 Certification earned – diploma issued 

Beginner 1 – 350 
Certification failed - certificate of 
completion issued 
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PowerPoint domains and subdomains 

Environment/ 
Methods/ Slideshow 

◼ Use the basic functions of the software 

◼ Know and customize the software environment and 

display 

◼ Create, manage, and customize slideshows 

Text Management 

◼ Apply formatting options to texts with fonts 

◼ Manage Slide Master view functions 

◼ Manage tables 

◼ Customize themes and manage templates 

◼ Use advanced functions and text properties 

Object Management 

◼ Create and customize animations 

◼ Create and modify graphic objects, and manage their 

display 

◼ Insert media tools and manage the OLE protocol 

Themes et Templates 

◼ Create and manage slideshows 

◼ Manage and customize the software environment and 

display 

◼ Use the basic functions of the software 

About the PowerPoint certification 

The Tosa PowerPoint Certification relies on a database of more than 300 questions. It is 

composed of 35 questions and lasts 1 hour. The algorithm adapts to each answer of the 

candidates to adjust the difficulty level of the questions until they reach the exact definition of 

the candidates’ level by calculating the limit of their high skills. 

 

Since the test is adaptive, the series of questions that each candidate gets is unique for each 

test. This uniqueness allows for a more accurate evaluation of the candidate's level. It also 

limits cheating and the memorization of questions on different passages.  

 

Our platform allows individuals to take the certification in class, in an approved testing center, 

or remotely via our integrated asynchronous online proctoring solutions.              

 

Our remote proctoring solutions provide added flexibility for both the administrator and the 

candidate, allowing the certification exam to be taken anywhere, at any time. The candidate 

only needs an internet connection and a computer equipped with a working webcam and 

microphone. 

 

Candidates receive a numeric score out of 1000 points associated to a proficiency level on a 

five-level scale. Candidates who score between 1 and 350 points don't earn the certification. 

They will not receive a diploma but a certificate of completion. Candidates who score 351 
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points or above earn the certification. They will receive a diploma by email within five (5) 

business days. If candidates score 551 points or above, they will also be eligible to a Credly 

digital badge. There is no requirement to be eligible to take the exam, but our 

recommendations to be well prepared on exam day are:  

 

- Take at least one Tosa PowerPoint adaptive assessment to estimate your level and 

get familiar with the test format 

- Use free practice tests on our website for training 

- Follow e-learning or training courses (average duration per level is between 10 and 

15 hours per certification so around 150 hours total)  
 

Tosa certification diplomas are valid for three years from the date of issue as skill levels evolve 

or decline over time, depending on the use of the software. New software and software 

versions are released every year, and skills must be updated. We cannot legitimately certify a 

digital skills level for more than three years. Limiting the certification validity reinforces the need 

for life-long learning and professional development.  

Tosa certifications can be retaken when it is expired. Earners willing to improve their score and 

level can also retake the exam at any time. 
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Tosa Sequence for Progressive Skills Development 

Students and professionals can tailor their certification journey with Tosa, demonstrating their 

expertise in ways that align with their unique needs and goals.  

With the Tosa PowerPoint Certification, starting at a basic level, users can progress 

vertically, advancing to productive, advanced, and expert levels as their skills grow. This clear 

path encourages continuous improvement and validates each stage of their development. 

Tosa’s structure makes it easy to track progress and showcase evolving expertise. 

With the Tosa Microsoft Office Bundle Certification, users can expand their skill set 

horizontally across Microsoft applications, mastering interconnected applications that touch 

on a broader range of competencies. This flexible approach empowers individuals to develop 

both depth and breadth in their skillset, enhancing career prospects and workplace versatility. 

 



 

Level 1 – Beginner User 

Between 1 and 350 points 
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The Beginner Proficiency is set for a score from 1 to 350, which is the lowest Tosa score 

category. Achievement of Beginner score defines little or limited knowledge of the 

PowerPoint application, including the application’s basic functions and features, highlighting 

the inability to use the application in a professional environment. 

Overview 

Domains Skills Assessed 

 

Environment/ Methods/ 

Slideshow 

 Identify PowerPoint 

 Recognize a PowerPoint presentation  

 Open and close the application 

 Know the most common tabs and their main 

functions (File, Home, Insertion, Slideshow) 

 Open and create a presentation  

 Create and/or insert a slide 

 

Text management 

 Increase font size 

 Change the policy  

 Change the color or size of the text  

 Switch from italics to bold  

 Underline text 

 Recognize bullet points or numbering 

 

Object management 

 Identify and insert a simple picture, table, or shape 

into a presentation 

 

Themes and templates 
 None 



 

Level 2 – Basic User  

Between 351 and 550 points 
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Environment, Methods and Slideshow 

PowerPoint’s environment  

Candidates demonstrate a basic knowledge of the PowerPoint interface and environment. 

They can open a presentation and are familiar with PowerPoint window elements such as the 

ruler, the status bar, and the Quick Access Tool Bar. Additionally, candidates are familiar 

with the ribbon, can easily move between ribbon tabs, and are familiar with most of the Home 

tab features.   

Working on a presentation 

Candidates possess the minimum knowledge needed to work on a presentation. They can 

open a saved presentation or create a new presentation from predefined templates. They 

can move throughout a presentation using the cursor or the keyboard. They can save a 

presentation or print it using default settings. They can also undo or redo an action, 

manipulate presentation slides in Normal view, as well as insert, delete, select, and move 

slides, and launch a slideshow. 

Business application: For example, for a content manager profile, these skills are useful for 

optimizing the creation of text or multimedia content and creating simple presentations to 

share internally. 

Text Management 

Text boxes 

Basic users understand how text boxes work in PowerPoint and can enter text in a 

presentation. They can identify content placeholders and insert text in them. They can 

perform a simple copy-cut-paste operation with the mouse or via keyboard shortcuts. They 

can use the spellchecker and know how to accept and reject its suggestions.  

Text formatting 

Candidates are expected to be familiar with basic text formatting tools. They can change font 

type and size, can bold, underline, and italicize text, change text color, and highlight color, 

and change text case. They can also apply basic paragraph formatting such as text 

alignment (left, centered, right, justified), text indentation (increase/decrease), apply shading, 

and insert a bulleted or numbered list. 

*Prior to the acquisition of the skills of the Basic level, the candidate will have 

mastered the skills of the Beginner level. 
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Tables 

Candidates know how to insert a simple table via the Insert tab and add or delete rows or 

columns. They can increase or decrease table size and merge cells. 

Business application: For example, on a content manager profile, these skills allow them to 

create digital content (blog articles, white papers, images, infographics, videos, etc.) and 

optimize their communication by creating and distributing content. 

Object Management 

Inserting graphic objects 

Candidates can insert simple graphic objects (pictures, photos, shapes, text boxes), and 

perform simple modifications of said objects, notably outline color and fill color. They can 

also resize and reposition objects.  

Simple animations 

Basic-level candidates have limited knowledge of animations but can identify animated 

objects in a presentation as well as transitions. 

Business application: For example, for a content manager profile, these skills enable them to 

illustrate content and develop an editorial strategy with multimedia supports in line with the 

communication plan in place. 

Themes and Templates 

Opening a template 

Candidates can open a presentation template, revert to default formatting of a presentation if 

necessary and make simple changes.  

Applying a template 

The basic level requires knowing how to apply a predefined theme to a presentation via the 

Design tab. 

Business application: For example, in the case of a content manager, these skills enable 

them to format and homogenize content for publication purposes and to make it available in 

digital format. 
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Overview 

Domains Skills Assessed 

 

Environment/ Methods/ 

Slideshow 

PowerPoint’s environment:  

 Open and close the application 

 Know the most common tabs and their main functions 

(File, Home, Create, Insert, Slideshow) 

Working on a presentation:  

 Open and create a presentation 

 Create and/or insert a slide  

 Select and delete a slide  

 Save and print a presentation  

 Use the Zoom function 

 Undo and redo an action 

 Use slideshow view 

 

Text management 

Text boxes:  

 Identify a text box 

 Copy and paste text  

 Recognize the spell checker suggestions 

Text formatting:  

 Change the text font size and type (bold, italics, 

underlined...) 

 Change text case  

 Change text color 

 Use highlight color  

 Create bulleted or numbered lists  

 Align the text 

Tables:  

 Create/insert a basic table 

 Change columns width and rows height 

 Add and remove rows and columns  

 Merge cells 

 

Object management 

Inserting graphic objects:  

 Insert a simple graphic object (picture, image, or 

shape) 

 Reposition an object in a presentation  

 Resize an object 

Simple animations:  

 Identify an animated object on a slide 
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Themes and templates 

Opening a template:  

 Open a presentation template 

 Revert to default formatting of a presentation  

 Make simple changes 

Applying a predefined theme:  

 Apply a predefined theme to a presentation 

 



 

Level 3 – Productive User 

Between 551 and 725 points 
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Environment, Methods, and Slideshow 

Navigating in PowerPoint 

Productive users have a good understanding of the features of the Home, Insert, Design, 

Review tabs, and to a lesser degree the View tab. They are fully familiar with Slide Sorter 

view and can easily work with presentation slides. They know various methods for inserting 

slides and can change slide orientation.  

Record and Print options 

Productive-level candidates master basic Save and Print options – they know the difference 

between the “Save” and “Save as” operations, can save a presentation as a PDF file, and 

are familiar with the compatibility rules regarding documents created with later or earlier 

versions of the application. Candidates master most printing options, such as selecting the 

number of slides to print per page. 

Slideshow options  

Candidates can use basic slideshow options. They can launch a slideshow from the 

beginning or from the current slide, can configure slide advancement (timed or manual), can 

use Presenter view, and apply predefined animations.   

Business application: For example, for a promotion manager, these skills allow them to 

develop operational marketing plans that they can share with their teams. 

Text Management 

Text formatting 

Candidates can create text boxes and format them (apply a fill or change the border), can 

change font style, character, and line spacing, use strikethrough, subscript, superscript, and 

apply text effects. They can additionally copy formatting, put text into columns and set left tab 

markers. 

Searching and modifying text 

Productive users can perform simple text searches within a presentation, either via the 

ribbon button or keyboard shortcuts. They can move throughout a long presentation via the 

“Go to” command, and can easily use the grammar and spellchecker, the thesaurus, or 

consult document statistics. 

Prior to the acquisition of the skills of the Productive level, the candidate will have 
mastered the skills of the Basic level. 
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Tables 

Candidates can manage tables and apply basic formatting. They can apply table styles, 

modify table borders, add a fill, format table contents, reposition a table and move it.  

Business application: For example, in the profile of a promotion manager, these skills enable 

the creation of elaborate presentations for all internal plans (marketing, sales, promotional, 

etc.) and for the development of content for information and communication media.    

Object Management 

Inserting and Formatting graphic objects 

Candidates can insert all types of graphic objects: graphs, SmartArt, and complex shapes 

like connectors. They can save a PowerPoint illustration as an image, edit, and arrange 

graphic objects, and adjust object positioning (background, foreground, Bring to Front, Send 

to Back). Candidates can apply an outline or add a fill to an object and crop an image.   

Animations 

The productive level requires candidates to know how to apply predefined motion paths to 

the text and objects. 

Business application: For example, for a promotion manager, these skills enable the use of 

text or multimedia resources for qualitative and quantitative studies or the presentation of 

cross-channel marketing plans, promotional actions or sales plans. 

Themes and Templates 

Themes options 

Candidates can apply predefined themes to an entire presentation or just to specific slides. 

They can change theme colors and fonts and understand the effect a new theme has on text 

formatting. They can also define background styles.  

Business application: For example, on a profile of a promotion manager, these skills are 

useful for making proposals for visual recommendations and formatting presentations. These 

skills are also used in the analysis of the positioning of offers and "search marketing", 

displays and affiliations. 

Overview 

Domains Skills assessed 

 

Environment/ 

Methods/ Slideshow 

Navigating in PowerPoint:  

 Identify different views (Normal, Slide Sorter, Notes Page, 

Slide Master) 
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 Master the different methods of inserting slides 

 Change slides orientation 

 Hide a slide 

 Insert and delete comments 

Recording and printing options:  

 Set printer parameters 

 Save a presentation as a PDF file 

Slideshow options:  

 Set simple slideshow configuration 

 Add transition effects to slides  

 Set slide timings 

 Use Presenter View 

 

Text management 

Text formatting:  

 Create a text box 

 Manage font styles  

 Change character and line spacing  

 Apply text effects  

 Format painter 

 Split text into columns 

 Insert text in a shape 

 Set tab stops 

Searching and modifying text:  

 Use the Synonym Dictionary 

 Use the grammar and spellchecker 

 Use the Thesaurus 

 Use the Find tool 

Tables:  

 Apply table styles 

 Change the table border and add a fill 

 Revert to original table style 

 

Object management 

Inserting and formatting graphic objects:  

 Insert various graphic objects (ClipArt, graphs, SmartArt 

diagrams) 

 Insert complex shapes (connectors, diagrams, bubbles, 

etc.) 

 Save a PowerPoint graphic object as an image 

 Change objects’ order (background, foreground, etc.) 

 Crop an image  

 Duplicate an object 

Animations:  

 Apply predefined motion paths to text and objects 
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Themes and 

templates 

Theme options:  

 Apply a predefined theme to the entire presentation or just 

to specific slides 

 Apply a background style  

 Change theme colors and fonts 

 



 

Level 4 - Advanced User 

Between 726 and 875 points 
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* 

Environment, Methods, and Slideshow 

Customizing the environment and display 

Advanced users have thorough proficiency of the PowerPoint environment. They are fully 

familiar with the contents of the PowerPoint window and can easily move between tabs to 

complete tasks. They can use the various views (Normal, Slide Sorter, Notes Page, 

Slideshow) and can customize the application interface by hiding tabs that are less useful to 

them. They can display the Developer tab and customize the Quick Access Toolbar and 

keyboard shortcuts, they can hide the ruler and show thumbnails or gridlines. 

Backstage mode and file formats 

Candidates show advanced usage of the File tab, via which they can manage files, define file 

options, access recent documents, and pin documents to the Recent Documents list. They 

are familiar with various PowerPoint file extensions such as .potx or .potm and can configure 

print options. 

Slides 

Candidates are familiar with slide arrangement and can use the Outline pane to arrange 

slides and move text. They can insert and edit page breaks, edit slide orientation, and insert 

and manage headers and footers.  

Slideshow 

Candidates master the launch and sequencing of complex slideshows. They can recognize 

and use the various PowerPoint views including Slideshow View, Presenter View, and 

Reading View. They can also configure a presentation to run automatically and set slideshow 

timings. 

Business application: For example, for a marketing product manager, these skills are useful 

for creating and customizing presentation materials for employees (marketing plans, market 

analysis, competitive intelligence, advertising or communication campaigns, etc.). 

Text Management 

Text Layout 

Candidates can use the most advanced formatting options. They can apply WordArt styles, 

advanced Paste Special options, and use the Clipboard pane. They can align text boxes, 

insert special characters, change text orientation, configure AutoCorrect options, use 

translation tools, and configure presentation language options. 

 

Prior to the acquisition of the skills of the Advanced level, the candidate will have 

mastered the skills of the Productive level. 
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Text organization 

Candidates can add bookmarks to PowerPoint presentations, can insert hyperlinks, and use 

the various Search and Replace options. 

Table Layout 

Candidates possess advanced knowledge of tables and table formatting. They can manage 

various table style options (header rows, total rows, banded rows). 

Business application: For example, for a product marketing/distribution manager profile, 

these skills enable them to create content for, for example, the implementation of 

communication campaigns for the release and promotion of the product, service or service. 

Object Management 

Complex graphic objects 

Candidates can insert all types of graphic objects in a presentation, including complex ones 

such as audio and/or video files or Flash objects. They can also insert objects created with 

other Office applications, such as Word and Excel, and can distinguish a linked object from 

an embedded one. They can also take a screenshot from within PowerPoint.  

Editing and organizing graphic objects 

Candidates must prove a solid mastery of the tools used to modify and arrange graphic 

objects. They can convert shapes and apply effects to them, retouch inserted images by 

changing color, luminosity, applying a filter, or deleting a background. They can use 

advanced vector tools and know how to handle the eyedropper tool. 

Customizing complex animations 

Candidates are fully familiar with the various types of animation effects: entrance, emphasis, 

exit, and motion paths. They also know the Animation pane and can configure Effect 

Options, animation triggers, animation timing, can use Slide Master view, add bookmarks, 

and use the Preview button.  

Business application: For example, on a product marketing/distribution manager profile, 

these skills are useful to create illustrated content, carry out market research, present 

qualitative and quantitative studies, or carry out competition studies. 

Themes and Templates 

Customizing themes and templates 

Candidates can customize themes and templates and use the Slide Master view to do so. 

They can also create and save a customized theme or template. 

Business application: For example, on a product marketing/distribution manager profile, 

these skills are useful for formatting presentations and mastering the form. 
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Overview 

Domains Skills assessed 

 

Environment/ 

Methods/ 

Slideshow 

Customizing the environment and display:  

 Know all the tabs and associated ribbons 

 Master the different views  

 Customize views 

 Customize the ribbon 

 Display the Developer tab 

Backstage mode and file formats:  

 Recover an earlier version of a presentation 

 Identify the different PowerPoint file formats (including .potx and 

.potm)  

 Configure printing options 

Slides:  

 Organize slides via the Outline pane 

 Move text via the Outline pane  

 Insert and manage page breaks  

 Manage headers and footers 

Slideshows:  

 Master the different modes of presentation (Slideshow mode, 

Presenter mode, Reading mode) 

 Configure a slideshow to run automatically 

 

 

Text 

management 

Text layout:  

 Apply WordArt styles 

 Perform a Paste Special operation 

 Use the Clipboard pane 

 Align text boxes 

 Insert special characters  

 Change text orientation  

 Configure AutoCorrect options and use translation tools 

Text organization:  

 Add bookmarks to a presentation 

 Insert hyperlinks  

 Master the Search and Replace functions 

Table layout:  

 Manage table style options (header rows, total rows, banded 

rows) 
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Object 

management 

Complex graphic objects:  

 Insert a video file or Flash object 

 Insert objects created with other Office applications (Word, 

Excel) 

 Differentiate a linked object from an embedded one 

 Take a screenshot from within the application 

Editing and organizing graphic objects: 

 Convert shapes and apply effects to them 

 Retouch an inserted picture  

 Arrange objects via the Selection and Visibility pane 

 Group and ungroup objects 

 Align objects  

Customizing complex animations:  

 Identify and apply all types of effects and manage effect 

options  

 Use the Navigation pane 

 Use the Slide Master View to configure animations 

 Manage slideshow launch triggers 

 Use bookmarks 

 Use the Preview button 

 Set slide timings 

 

Themes and 

templates 

Customizing themes and templates:  

 Master the Slide Master view 

 Create and save a theme (extension .thmx)  

 Create and save a custom template (extension .potx or .potm) 

 

 



Level 5 – Expert User  

Between 876 and 1000 points 
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Environment, Methods, and Slideshow 

Interface customization 

Expert users completely master the PowerPoint environment, including all ribbon tabs and 

their associated features, as well as the various PowerPoint views. They can configure the 

application to perform needed tasks, including Backstage View options, the Quick Access 

Tool Bar, and the ribbon tab. They are familiar with advanced Save (i.e., AutoSave) and Print 

(i.e., printing several slides on a page) options. They possess thorough knowledge of the 

Developer tab, can create complex macros, and fully understand PowerPoint file extensions. 

Presenting and Broadcasting 

Candidates master all of presentation delivery options. They can easily use the zoom, the 

simulated laser pointer, and annotations. They can deliver a presentation in loop, create a 

presentation video, and publish a presentation to the Web. They fully understand 

compatibility modes and all the options for document protection. They understand the Mark 

as Final command, can encrypt a presentation with a password, restrict who may edit a 

presentation, create a slide library, and merge and compare presentations.  

Business application: For example, for a graphic designer profile, these skills allow them to 

customize their presentations and adapt them to their content (create templates from a 

client's graphic charter, create commercial supports, financial presentations, etc.).    

At this level, the candidate can train on the software. 

Text Management 

Formatting 

Expert users possess exhaustive proficiency in formatting tools. Candidates can customize 

themes (i.e., change theme fonts), apply special text effects, create a custom style and a 

Quick Style set, and use the Style Inspector. They are thoroughly familiar with detailed font 

options, such as the application of hidden fonts, OpenType font options, Paste Special 

options, WordArt styles, document checking options, and the Outline mode.  

Table Layout 

The expert level requires candidates to know how to easily create, format, and perform 

advanced editing of tables, such as inserting a table background and are thoroughly familiar 

with all table style options. 

Business application: For example, for a graphic designer profile, these skills allow them to 

create content perfectly adapted to his needs or those of his clients, in which he masters the 

content as well as the form (font, tables, WordArt, etc.). 

Prior to the acquisition of the skills of the Expert level, the candidate will have mastered 

the skills of the Advanced level. 
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At this level, the candidate can train on the software. 

Object Management 

Complex object management 

Candidates can expertly manipulate graphic objects – they can insert any type of objects, link 

and embed them in a presentation, and edit them. They are fully familiar with image 

retouching options, and the application of effects to objects. They know how to modify 

shapes in point mode, have mastered advanced vector tools (combination, intersection, 

subtraction, and shape union), and can manipulate the eyedropper. They perfectly handle 

audio and video objects. 

Animation 

Expert users can expertly manipulate animations and transitions including special effects 

such as speed, direction, delay, repetition, and locking a motion path. They can also animate 

table cells, duplicate an animation, configure timing, identify, and configure a precise 

animation sequence, and configure animation triggers. They can create automatic 

animations via the Slide Master.  

Business application: For example, for a graphic designer, these skills are useful for 

illustrating and revitalizing their presentations (creating templates from a client's graphic 

charter, creating commercial supports, financial presentations, etc.).    

At this level, the candidate can train on the software. 

Themes and Templates 

Themes and templates 

Candidates master themes and templates. They can easily configure slide layouts, create 

slide masters, create multiple slide masters for a single presentation, edit and reapply a slide 

layout, use font sets, and invert theme colors.  

Business application: For example, for a graphic designer profile, these skills are necessary 

to customize PowerPoint themes and templates and even to create them in order to adapt 

presentations to a defined graphic charter.  

At this level, the candidate can train on the software. 
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Overview 

Domains Skills assessed 

 

Environment/ 
Methods/ 
Slideshow 

Interface customization: 

 Master the Developer tab features 

 Open and save a presentation with a macro 

 Customize the presentation window  

 Configure AutoSave options 

Presenting and broadcasting:  

 Master all presentation options (zoom, laser pointer simulation, 

annotation) 

 Create and manage custom slideshows 

 Broadcast a slideshow in loop 

 Master all PowerPoint file formats  

 Create a presentation video  

 Publish a presentation to the Web 

 Manage different modes of compatibility  

 Protect a presentation 

 Use slide libraries  

 Merge and compare presentations 

 

 

Text management 

Formatting:  

 Manipulate WordArt styles perfectly 

 Custom styles and Quick Styles set 

 Use advanced font tools 

 Insert an equation  

 Use of Paste Special options 

 Manage spellcheck options 

 Know the Outline pane 

Table layout: 

 Insert a table background  

 Master the table style options perfectly 

 

 

Object 
management 

Complex object management:  

 Insert any type of object 

 Use all picture editing 

 Use advanced positioning and alignment functions 

 Master vector tools  

 Manage audio and video objects  

Animation:  

 Master any type of animation 
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 Manage any type of settings (sound, text animation, timing) 

 Manage slide transitions 

 

 

Themes and 
templates 

Themes and templates:  

 Manage slide layout 

 Create a slide master and configure its options  

 Create multiple slide masters for a presentation 

 Change and reapply a slide layout 

 Master the use of font sets 

 Invert theme colors 
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